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LegUpTools

This low-cost, pay-as-you-go option lets you convert PDFs
from most any source to InDesign documents.

9 MINUTE READ

I'D BET THAT SOMETIME IN THE NEXT
few months you will need to convert a PDF
to an InDesign file. Perhaps a client has
requested some edits to a document, but the
only electronic files that exist are PDFs. Or
your InDesign files for an important project
are corrupt and you don't have a backup,
but you do have a recent PDF. Maybe you
need to convert to InDesign a document
created in Canva or Adobe Express, a layout
from Illustrator, or a presentation built in
PowerPoint.

LegUpTools is a low-cost way to convert
PDF files exported from almost any source to
editable InDesign files. The barrier to entry

sy Keith Gilbert

is very low: There is nothing to purchase
up front, and the website is extremely
easy to use.

OmniMarkz by Markzware (macOS
only, $389/year or $599) and PDF2ID from
Recosoft (macOS and Windows, $299/vyear)
are both robust solutions for converting
PDFs to InDesign files. Both offer many
more conversion features and options than
LegUpTools. But the price point is completely
different. Unless you need to convert lots of
PDFs, you might find it difficult to justify the
price of these tools. This is where LegUpTools
excels—you pay as you use it, at only $0.25

per page.
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How It Works

The process couldn’t be simpler. Just go
to leguptools.com, create a free account,
purchase a few page credits, and upload
your PDF.

In a few minutes, you'll receive an email
(FIGURE 1) with a link to download a ZIP file.

WHAT ABOUT THE OTHER
PRODUCTS?

You can dig into the CreativePro
archives to learn about the

pros and cons of the other PDF
conversion tools mentioned here in
reviews of OmniMarkz and PDF2ID,
by Nigel French

and Steve Caplin, o °

respectively. e | —

Reprinted by permission from CreativePro Magazine

The archive contains an IDML file (which
can be opened by any version of InDesign
going back to CS4) and a folder containing
the images, extracted from the original PDF
and linked to your new file.

When you first create an account, you get
two free page credits to try out the system.

Leg Up kgilbert@gilbertconsulting.com | Sign out
gTools ° 9 ¢ 9

You have 110
page credits

Upload your PDF file

max 25MB * max 100 pages = each page uses one credit
Once your InDesign file is created, you'll get a download link via email,
typically within 10 minutes.

Choose File No file chosen m

Express_property.pdf uploaded successfully. Conversion started, expect an email
with download link from us shortly. You can now upload another PDF.

Any queries, visit our EAQ page to learn more, or contact us at
support@leguptools.com

About FAQ Resources Terms

LEGUPTOOLS

From there, you can purchase additional
credits for $0.25 per page, in any quantity
between 2 and 300. If you have unused
credits that you no longer need, LegUpTools
will issue you a refund.

Every time you go to upload a new PDF,
the website displays your number of credits

FIGURE 1. The upload page (left) gives you helpful

instructions in uploading your file. A few minutes
after submitting your PDF, you'll receive an email
with a download link (right).

LegUpTools
PDF to InDesign conversion
To: Keith Gilbert

Hello,
The converted file is now ready for you to download.

The file is a zip file. Inside the zip file is an IDML file which you can open in any recent
version of InDesign, and a folder of linked images.

The download link will expire in 24 hours.

My goal is 100% customer satisfaction. Therefore if after you've reviewed the

converted file, you feel that the conversion hasn't saved you $0.50 worth of time, then
please reply to this email stating the issue(s) and | will credit you in full.

If you have any suggestions on how | can improve this service then it would be great to
hear from you, please contact me by replying to this email.

Kind regards,

Tom Robinson, LegUpTools
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remaining (FIGURE 2). If you aren’t happy with a
conversion or find the output unusable, they

promise to either restore your page credits or,
if you prefer, refund your money.

Buy Credits for PDF to InDes! X aF

2% leguptools.com/buy_credits

Set Your Expectations

Because of the complexities of the PDF file
format, converting PDFs to other formats is a
complex undertaking. Extracting formatted
text in a meaningful way while preserving
the formatting is particularly challenging for
a variety of technical reasons.

LegUp kgilbert@gilbertconsulting.com | Sign out
g Tools ¢ @9 9 °
You have 155
page credits

Buy credits

Page credits cost $0.25 per page. Each credit enables the conversion of one

page.
You can buy any quantity between 2 and 300.

Buy credits

[ Powered by stripe ]

Qty: 10

FIGURE 2. LegUpTools works on
a credit system, with each page
costing S0.25.

If you have credits you no longer need, we will issue you a full refund for

them.

Any queries, visit our FAQ page to learn more, or contact us at

support@leguptools.com

Reprinted by permission from CreativePro Magazine
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Take paragraph and character styles as
they are used in InDesign. Any styles used
in an InDesign layout aren't preserved when
you export your file to a PDF, so if you
convert a PDF back to InDesign, you lose the
names of the styles as well as which text is
assigned which style.

LegUpTools creates paragraph and
character styles named Paragraph_Style_1,
Paragraph_Style_2, and so on for each
unique set of formatting that it finds in the
converted document. More often than not,
considerable cleanup is necessary to use
these styles, but for long documents with
lots of repetitive formatting, it can be a big
timesaver.

So, what else can you expect in an
InDesign file converted from PDF with
LegUpTools?

» While the typeface and style assigned

to text is preserved accurately, in most
cases the font names in the file won't
match the actual font names on your
system. For example, the converted PDF
may specify text that is formatted with
Acumin Pro Cond Regular, when the

To subscribe, visit creativepro.com/issues


https://creativepro.com/issues/

nREVIEW LEGUPTOOLS
y

actual font on your system is Acumin » Line endings will often vary slightly from

Pro Condensed Regular, or Klinic Slab the original.

BoldItalic instead of Klinic Slab Bold » You may see line breaks inserted in odd FIGURE 4. Text will often appear in independent,

Italic. Thankfully, this is pretty easy to fix locations in the text or random spaces unthreaded frames. Also note the overset text

with Type > Find /Replace Font (FIGURE 3). occasionally removed between words. frames for column 1 and the page number.
Check Spelling and Find /Change can

help to qlllelY ldel’ltlfy these cases re Women Human? heory of Lengthwise SE(ig and Very Big
) nd Other International olling ole Drilling
. . . . Ulpa doles aut quatibus, ut anim- Tur alist eicienistiis que et adit
} An mar 1n uldes Column uldes and Dlalogges pos voluta sunt et laboreh enihil ium ideles seque voloribus earum
y g g ) g ) itunt, ististo eum rem. Ut !abo.. moluptate disquas peritatur senda quatquatur? Pid uta id quodi od
Facep!:lbus plit officia poreria qui od elenim usanimp oribea sunt fugit quia volupiet remodist utem. Nam
e e e e 0s i, sandeffferae pre lam, sollume et venda nullaut odi de alia aut laut endae pra quo quam ipis mos aliqui
ru er gu]_ eS Specl e 1n t e aut Orlng nestlslto est ml"QI’la;TlE VCL:UPtaltUT as is assimaximus, te nobisi doluptur consedipsus et officim aximpori con-
1 sit volor mos et quid quoditat lam alignatiur mi, quo omnimus aperum secus a volecto esciduci to consequia
Flnleeplace Font . . h untoril;)u;ar fugit qulgnt eate conec-| quidipid molorias aut doluptatur nonet doluptam num eiusam accus.
ur, quis dolorem exeri consequiame t volupti t, ell |
program are not written into the PDF, so e e consedt suntvoluptis amusant, lls co clpa
11F in D Fonts in Graphics: 0 t,lconetusae rTvoIc:jre:'n se qui it, samet quiam excerovit atumqui Fancy Coffins to Make
onts in Document issi . h ) 11 ] h 1 ﬁl oluptatur aut liqui dolorat ectore inihiliqui voluptum faccatiati omnis
Lol FOHtS: 8 t ey Wl not appear 1n t e InDeSlgn e. pre este volupta commossi cuptasi suscidqe Iecear,ijorautecer essimus ourself (a book for
Type 1 Fonts: 0 nirlnpore ndipsu;antib:‘sd.ahrjlc‘ﬁt siminctus rem si dolo es diore sequia oodworkers)
- § 7 ’ ) olorro testorro dolorendi nihilit ut etquam, sant. Igendus poriosa ndest, quiate re pli-
Font Information } Ou ]_]_ Often See Cases V\?here teXt doesn t :!tfe dolorporio et, sa conet labor quiat facepta epudaer oviducid quo
. itius. oloris et lia nonsedi tatium
Acumin Pro Cond Regular . t ﬁt . th f t d f . t The Potatoes of Bolivia qui ne opta dolorpore omniendis
H H : : as dolor maximendent quam dellest
Klinic Slab BoldItalic Find First q.U]' e 1n e rame Crea e Or 1 ’ he 120 year diet by Their Breedlngl maiorrum aut modita que sim
| lab Kital . . . taturitate derovit issitaq uistorepro alue and Evolutiona ry nulparibus rempos ut velignam imi,
Klinic Slab Bookltalic b Ir] h 11 eliquist opta veratat enestoreri vel i i conestemodi aut as sitiatque coraecti;
SO ].t eCO eS Overs et. T 1S ].S usua y modis aut volupti cuptae delignit et Euealizz(i:l)lgssemigiemporibus, quam nullaut que con rate nonsequo

KlinicSlab Bold ipiti te sum volescipit entus seque quam, quia seceperrum estium eiunt ipiet delisiminis porem labores rem
dis eic te sitios volupta quia quis

. - N .
sit, corepta quodis enimeni mporum ipsanim doluptam fugitem dus apid
Qualion Bold C han g € A” * ea‘S 1]'y ﬁXe d M ipsum e‘fm et d,,e"‘am/ na‘tetu re ma intia sam andita ime quae natas eﬁzr:;pi:%e;umsnr':r\‘/::ti;:;i:r:gt
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Qualion Bolditalic } E Ven thoug |: ] t |: ] e SO l | rce dOC l | [ [ l e [ ]t quiam nullatatur? Quiam vel eosti et recat occusci atumquae ipid ute quodici di ipsum adit es dolorum
ra idis cupta volut eum doluptae maioriatet mo bero eum rehendi explign imoluptatia et veratiaernam

i i N . num, sapicipsam cus.
enim utem fuga. Lia plamet eum idelectur autatur, simus corerae picip

1 ] facias estorem porporiatem saer- f :
s T might have text flowing from frame to s storem perpoiem || eremaus v cororadtemaut
" A e o A etur antur, te omnis re nonseque Kr‘]lttlng Wlth Dog Ha]r
sit arum facidebis simi, nimoluptatia

Font Famlly Acumin Pro CondenSEd frame and page to page, muCh Of the dustis acepero estionecab illuptatet oluptatem volor se dus. elit volorum ad qui dis aut ea

- N ; nullibus ella venis venimus volo
More Info olo quam lacilit litatescias eriaepr quiasperum harciatiunt ut et perum

ipsanis quam quiatur, sitatemporum

. . . epratin ihiliqu a(e_ceribus_egdolorior Innovation and quam volorpos sam endusap itatem
teXt 1n the conve Ited ﬁle W].].]. app ear in sequas erovit qui re nobiscia plabo. ; faccullant rem quatur aute doluptaty
Nem volor assed eum ilibus, senditi the Rise of the delendic temo voles dolorepti at. EI:lj

isciam ut quae rehent vollor sim si Tu ﬂﬂel || ng | ndustry

independent, unthreaded frames. For s e v ndios 371 | et vt que i cune, B

porio totaerum experum guuntur

Font Style: Regular

() Redefine Style When Changing All

epudaep taquati cum fuga. Nequiati-

multi-column layouts, sometimes the } R i )
FIGURE 3. In many cases, the fonts reported text appears correctly in a multi-column
as used in the converted PDF won't exactly text frame and other times in separate

match the names of the same fonts that you unthreaded side-by-side frames (FIGURE 4).
may have on your system. , —
I never observed text flowing from page

to page. The free TextStitch tool from
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Rorohiko can be a big help in threading
frames back together.

» The PDF format understands nothing
about Parent pages, so in a PDF produced
from InDesign any objects that may have
originated on a Parent page (such as page
numbering, headers, and footers) will
simply appear as repeating objects on
each document page.

P If LegUpTools sees a hyphen in a
paragraph, it turns hyphenation on for
that paragraph; if no hyphens appear,
hyphenation is turned off for that
paragraph. If you don't realize this,

you could be confused as you edit the
document and wonder why hyphen-
ation is inconsistent. You may also

see scattered hyphenation in odd and
incorrect places in the converted file.

Perhaps I'm being nitpicky, since in most
cases it is very, very close.

» Bitmap images will be extracted from the

PDF and included as linked images in
the InDesign file, named as image_0_1.
png, image_0_2 jpeg, and so on, with
the first digit being the page number
(with the pages starting in sequence
from 0) and the second digit being

the image sequence on that page. The
image quality will be only as good as the
PDF—if the original file’s images were
downsampled to 72 ppi when the PDF
was created, that is how they’ll appear in
the images supplied with the converted
IDML file. You'll want to check image
resolution in the Window > Links panel
or via Window > Output > Preflight to
ensure the image resolution will meet

LEGUPTOOLS

SECURITY CONCERNS

As you would do with any cloud or
web-based service, if you are working
on proprietary, confidential materials,
you will need to determine if LegUpTools
meets your security standards.

According to LegUpTools, “Access to
your files is strictly limited to automated
processes necessary for converting your
uploaded file to InDesign format, with

no human access to file content unless
explicitly authorized by you for support
purposes.”

your needs.

» Placed vector graphics will be converted
to InDesign vector objects.

» Tables are particularly difficult for
convertors like LegUpTools, because
PDFs can't explicitly identify tables, rows,
columns, and cells. So LegUpTools looks

P If your document contains a mix of left-
aligned, center-aligned, and justified text,
LegUpTools will often get the paragraph
alignment wrong.

» Text and graphic frames will be sized and
positioned within a couple of points of
the size and position in the original file.

You can read the company’s full security
statement in the FAQ.

Reprinted by permission from CreativePro Magazine To subscribe, visit creativepro.com/issues
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through the file, identifies collections of ) .

lines and other objects as a table, and _ i, S LAl
attempts tO COHStIUCt an InDeSign ta.b].e g . From stylish new builds to classic suburban dwellings,

there's something for everyone

that looks like those lines and objects.
This works well with some tables and
not as much with others. According to

the developer, you will have the greatest ' ” T

success with tables that contain visible

gridlines and tables originally created in — AsktheExperts
InDesign. e | . o oo ey

» Only languages that are read left-to-right ;. - 2 i

are supported. . . ” A\ e el

» Password-protected PDFs can't be — —

converted.

In most of my tests, I was pleased with Qur Hottest New Listings
the overall output from LegUpTools. I was i, | e .,
surprised by the accuracy of tables, complex 2 L . i o
vector objects, and bulleted lists. As you'd = g oo | “"i e

utdoos amenties, and 3 venss of comasunity, This shifthas

FIGURE 5. These two pages were created in
Adobe Express (top), exported as PDF, and
converted to InDesign (bottom). Frame edges
and hidden characters are displayed on

B i o o — & Q: How can | improve m ]
the InDeSlgn pages SO y0U Can See hOW the " : ., d Z‘J.."n'f.f'l;m..wW.,...‘,.......,.,.,...w,;‘_ - irzr:s;r]t:::;%forep:ttiny
pages are constructed. — -, SIS,
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WHY CAN'T | JUST OPEN A PDF IN INDESIGN?

For years, users have been asking to be able to open a PDF in
InDesign—the feature has close to 600 votes on the InDesign
Feature Requests page. And you'd think that Adobe, as the
inventor of the PDF standard, would have inside knowledge to
be able to do this better than anyone else, right?

1d)

Well, theyre working on it.

A recent public beta of InDesign introduces the ability to simply open
a PDF. When you open a PDF with File > Open, it uploads the InDesign
document to the cloud, converts it, and returns that converted file as
an untitled document in InDesign.

This is a work in progress. In my opinion, Adobe still has a long way to
go before this feature should see the light of day in a release version.
In my limited tests, the beta output was worse than LegUpTools in
some aspects and better in others, which illustrates the complexity of
this task.

One big limitation of the beta feature is that it can open only PDFs
that were created using InDesign, which really limits its usefulness.

Reprinted by permission from CreativePro Magazine
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expect, the simpler the layout and format-
ting, the better the conversion (FIGURE 5).

Should You Use It?

The alternative to using LegUpTools, or any
other conversion tool, is to export or copy
text and images from the PDF and then
laboriously rebuild each page in InDesign.
(See this how-to post from the developer

of LegUpTools for some useful tips on how
to do this efhiciently.) In most cases, it will
be much faster to convert a PDF directly to
InDesign format with LegUpTools, even with
the document likely needing cleanup after
the conversion.

To my mind, a “micropayments” model like
LegUpTools, where you pay for only what
you use, is very attractive for a tool like this.
I don't need PDF conversion very often, but
when I do, I'll know that I have an affordable
tool at my disposal. I'm glad to have this tool
in my bag of tricks.

Keith Gilbert is a design consultant, developer,
educator, speaker, and author. His work has taken him
throughout North America, Africa, Europe, and Asia.
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His clients have included Adobe, Apple, Target, Oracle,
and the United Nations. He is the author of several
popular titles for LinkedIn Learning, Adobe Press, and
CreativePro. Find him at gilbertconsulting.com.
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